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1 Installation 

The current version of CADS Revit SCIA Engineer Link works with Revit Structure 2016, Revit 2017 
and Revit 2018. You will also need a copy of SCIA Engineer installed on your system but it does not 
need to be authorised. CADS Revit SCIA Engineer Link needs to know the version of SCIA Engineer in 
order to create the correct version of the export file. 

For full details and the installation file for Revit please go to 
http://www.cads.co.uk/revit_interface.html and download the documents relating to the installation 
and use of the program in addition to this document.  

Document Description 

Release Notes This details the supported versions of Revit and SCIA Engineer and the 
enhancements and bug fixes to the latest version of CADS Revit SCIA Engineer 
Link. 

Getting Started CADS Revit SCIA Engineer Link configuration and basic usage notes. 

Check List Aide memoir when creating projects, this list should be submitted for all requests 
for support on CADS Revit SCIA Engineer Link. 

Please refer to this document before installing or using the software. 

Note: 

We suggest that you uninstall the previous version of CADS Revit SCIA Engineer link before starting 
the installation of the latest version of CADS Revit SCIA Engineer link.  

The mapping databases is updated in the latest version of CADS Revit SCIA Engineer link (2018.0). If 
you wish to use any of the existing databases or any pre-defined customised databases, please copy 
them into the folder C:\ProgramData\CADS\Revit to Scia Engineer\Revit 20xx\Mapping Databases.  

Please note that the user table created in the previous versions of CADS Revit SCIA Engineer link 
cannot be used with the new version. 

 

http://www.cads.co.uk/revit_interface.html
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2 Work flow 

 Revit Architecture model to SCIA Engineer round trip 

In the instance where you have to use a project created in Revit Architecture to create the Revit 
Structural model it is advisable that you use the Link Revit command and the Copy and Monitor feature 
to produce your own model in Autodesk Revit using the default Structural template. This ensures that 
your model is defined correctly using Structural elements as opposed to Architectural Concept 
Elements. 

 Revit model to SCIA Engineer round trip 

Create your Revit model based on the correct Structural template for the code of practice you are 
using. This ensures that the model is created using Structural elements and the Analytical model is 
enabled. The model that is exported from Autodesk Revit  to SCIA Engineer is based on the Analytical 
stick model and not the presentation model.  

 SCIA Engineer to Revit round trip 

Models created in SCIA Engineer are based on the analytical centre line. When the model is 
transferred from SCIA Engineer to Revit the members will be transferred based on the analytical stick 
model created in SCIA Engineer. Member offsets and eccentricities will be transferred if they are 
supported by the particular elements in Revit. Where these offsets and eccentricities are not 
supported a warning message will be issued in the transfer log file in CADS Revit SCIA Engineer link. 
These individual elements will need to have the eccentricities applied manually in Revit to create the 
correct presentation model and corresponding general arrangement drawings.  
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3 Creating the Revit model 

Listed below are some suggestions that will help optimise the transfer of the Revit model to SCIA 
Engineer. 

 Revit template 

You may use your customised Structural template but ensure that the customised template is created 
from a default Revit Structural template deployed by a Revit installation. The template should be 
configured to use the same Units as the SCIA Engineer model.  

 

Figure 3-1: SCIA Engineer - Units  

 

Figure 3-2: SCIA Engineer – Units dialog 
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It is recommended that you upgrade your customised template file when migrating to a higher version 
of Revit. 

 How to view the Analytical model 

The model transfer to SCIA Engineer is based on the Analytical Stick Model created in Revit.  

You can view the analytical model in Revit Structure by going to the Properties dialog and selecting 
the Visibility and Graphics Overrides then clicking on Edit and switching on the Analytical Model. 

If required you can disable the Model Categories to give a clearer view of the Analytical Model. 

 

Figure 3-3: Revit Structure - Visibility/graphics overrides  

 Creating a test model 

Before using the CADS Revit SCIA Engineer link on a major project it would be wise to become familiar 
with the software by creating a test model. A few key points to look for: 

1. This model should incorporate the structural features you wish to specify in your projects so that 
it will allow you to test the round trip from Revit to SCIA Engineer and vice versa. For example, if 
you are using a custom Revit Structure family (*.RFA file) then it will be useful to create a member 
using the Revit Structure family (*.RFA file) and exporting it to SCIA Engineer to check if the cross 
section type and member eccentricities are transferred correctly. 

2. Ensure that the analytical model is in the correct position and connected before attempting to 

export it to SCIA Engineer. Please see the section below on Analytical Checks. CADS Revit SCIA 

Engineer Link uses the Analytical Model in Revit for exchanging models between Revit and SCIA 
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Engineer. The analytical alignment can be adjusted in Revit for all structural elements. The figure 

below shows an example of a Beam. 

 

Figure 3-4: Revit - Analytical properties    

3. Most importantly, make sure that the building you model in Revit is one that you could model in 
SCIA Engineer and is a valid model that can be analysed. For example, if the members are not 
connected in Revit then the same problem will be reflected in the SCIA Engineer model too. Please 
refer to the figure below: 

 

Figure 3-5: Analytical lines not connected in Revit model 

4. The Revit model must be saved before attempting to export it to SCIA Engineer. 

 

 

Revit: Although these members appear 
to be joined, the analytical lines are not 
connected. 

SCIA Engineer: Members are transferred on 
the basis of analytical lines; hence, one of the 
members is not connected. 
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 Levels 

Ensure that the Base Level and Top Level of columns & walls are set to the nearest Revit Level. 
Otherwise SCIA Engineer may not be able to resolve the position of the element correctly. If the 
vertical offsets (Top Offset and Base Offset) in Revit are applied, do not allow them to cross another 
Level. Floor slabs should also be assigned to the nearest Level, otherwise the analytical slab position 
in SCIA Engineer will be incorrect.  

In the Revit example shown below a separate level for the lift shaft roof was not created. The roof has 
been offset from Level 3 and the Analytical Floors setting was set at Projection -> Level 3. Whilst the 
presentation model is correct, the analytical model is incorrect and would be drawn on Level 3 when 
exported to SCIA Engineer. This behaviour is sometimes observed when a Revit file is migrated from 
the lower version to a higher version of Revit. 

 

Figure 3-6: Revit model - Difference between physical and analytical floor position  

The correct thing to do in this instance is to create another level above Level 3 with the Analytical 
Floors settings set to Auto-Detect and assigning the lift shaft roof to this level. 

 Offset framing & Column members 

3.5.1 Vertical offsets 

The vertical offsets for beams can be provided in several ways. Two different cases and their 
implications are described below. It is always useful to agree with the Structural Engineer on the 
preferred method of modelling to ensure minimum rework is required by the Structural Engineer in 
SCIA Engineer. 

Case 1: Vertical offset using Z offset value in Revit  

In this case, a beam is drawn in the floor level, aligned with other beam and column top positions, but 
offset by 300 mm using the Revit properties. 

 

Lift shaft roof slab - graphically correct with 
offset from Level 3 

Lift shaft roof slab - analytically incorrect and 
assigned to Level 3 
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Figure 3-7: Revit Structure - Vertical offset provided with z Offset Value  

CADS Revit SCIA Engineer Link transfers the model to SCIA Engineer based on the Analytical lines. 
Hence, the analysis model in SCIA Engineer will be as shown below: 

 

 

Figure 3-8: SCIA Engineer - Vertical offset case 1 

Case 2: Vertical offset by drawing the beam in position 

In this case the beam is drawn in place by creating a work plane in Revit instead of specifying an offset 
from the floor level. Although the physical position of the beam is the same as that described in Case 
1, Revit automatically adjusts the analytical line for the beam to align with the top of beam. 

Rendered Model Stick Model 
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Figure 3-9: Revit model - Beam drawn in place with Z Offset Value = 0 

The analysis model transferred to SCIA Engineer in this case will be as shown below: 

 

Figure 3-10: SCIA Engineer - Vertical offset case 2 

The physical locations of the beam in both cases were identical, but owing to the difference in the 
analytical line position the model transferred to SCIA Engineer is different.  

Rendered Model Stick Model 
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3.5.2 Lateral offsets 

Lateral offsets are allowed only for beams and braces in Revit. The lateral offsets can be applied to 
beams and braces in Revit and are mapped appropriately in SCIA Engineer.  

  

Figure 3-11: Lateral offset between Revit model and SCIA Engineer model  

Note that there is no provision to offset columns from its local reference axes in Revit. The implications 
are elaborated in the Eccentricities section. 

3.5.3 Eccentricities 

In the Revit model you might be required to align framing elements to one face over several storeys. 
An example of this would be walls of different thicknesses and concrete columns of different section 
sizes. Revit will automatically adjust the analytical stick model to align them together whilst keeping 
the presentation model correct. These eccentricities are correctly exported to SCIA Engineer.  

If the section properties are not changed in SCIA Engineer and the model is exported back to Revit, 
the framing members will keep the original alignment in Revit. Otherwise, they will need to be 
adjusted manually in Revit to ensure the presentation model is correct.  

You can track amendments to your Revit model using the Review & Export / Review & Import / Select 
Changes options which will highlight the changes in geometry, section size and material type as well 
as new elements that have been added. Please refer to the section on this command at the end of the 
document. 

In the example given below, a three storey high wall is modelled in Revit. The analytical line is 
automatically aligned based on the centre line of the top column (may vary depending on how the 
wall is modelled). 

CADS Revit SCIA Engineer link will transfer the model based on the Analytical lines. Thus columns will 
be aligned as shown below: 

Revit: Beam with lateral offset, Y 
Offset Value = 250mm 

SCIA Engineer: Beam with lateral 
offset, ey = 250mm 
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Figure 3-122: Wall aligned to outer edge with Auto-Detect analytical lines in Revit  

Another alternative is to manually change the analytical line position using the Revit feature for each 
wall position. 

 

Figure 3-13: Wall aligned to outer edge with manually adjusted analytical lines in Revit  

The walls are still physically aligned to the left edge but the analytical line is present at the centre line 
of each wall storey. In this case, CADS Revit SCIA Engineer Link will transfer the model to SCIA 
Engineer to match the physical location of the wall in Revit as above but the nodes at each storey level 
will be disconnected.  

The adjustment made to the SCIA Engineer model will not be overwritten by CADS Revit SCIA Engineer 
Link in a subsequent update if the member to which the adjustment is made is not changed in Revit. 

 

Revit: Wall aligned to outer 
edge with Auto-Detect 
analytical lines 

 

SCIA Engineer: Wall 
aligned as per analytical 
lines 

Revit: Wall aligned to outer 
edge with analytical lines 
manually adjusted to 
centreline of each wall 
storey 

 

SCIA Engineer: Wall 
aligned to outer edge 
resulting in nodes not 
connected at each floor 
level  
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For example, the structural engineer may provide eccentricity for Wall 1 in SCIA Engineer, in a 
subsequent update from Revit the eccentricity in Wall 1 will be retained as long as Wall 1 is not 
changed in Revit.  

 Enable Analytical model 

Ensure that any structural element you want to export to SCIA Engineer has the option Enable 
Analytical Model ticked in the Revit Properties dialog. You may also have to enable the structural 
model on some elements. 

 

Figure 3-14: Revit - Enable Analytical Model  

 Zero length elements 

If there are elements on the model which have no physical length, CADS Revit SCIA Engineer Link will 
flag them in the log file while exporting the model to SCIA Engineer. You need to remove them from 
the model before trying to export to SCIA Engineer. 

 Openings in slabs or walls 

Where an opening coincides with the edge of a slab, or a wall, it is best practice to define the boundary 
of the slab around the opening. 

When a hole is required within the perimeter of a slab or wall do not use the edit boundary option to 
add the hole. Instead, you may create the holes using the “Opening option”.  



Revit SCIA Engineer Link Best Practices 

 

 

   

 

12    Copyright © 2017 Computer and Design Services Limited 

 

Figure 3-15: Revit– Slab openings 

Owing to application limitations, it is not possible to import changes to the slab boundary in SCIA 
Engineer if the number of nodes is modified. It is best practice to use the Opening option whenever 
possible. 

3.8.1 Shaft openings 

In Revit it is possible to define an opening passing through the entire height of a building or through 
selected levels using the shaft opening option. These openings are transferred from Revit to SCIA 
Engineer as individual openings as there is no associated type for such an opening in SCIA Engineer. 

When shaft openings are defined in Revit, care should be taken while updating the model from SCIA 
Engineer. It is recommended to set the option Update 2D member openings to No during import 
otherwise the openings will be lost on import. An alternative to avoid the issue is to define them as 
individual openings in Revit rather than using the shaft opening option.  

From Revit link v3.1 onwards, any change done to the shaft openings in SCIA Engineer will be 
automatically ignored on import to avoid the loss of opening during round trip. 

 Dummy elements 

A dummy element is a short piece of structure.  Rather than use a small element, join the awkward 
connections with either model or detail lines. Dummy elements will not be exported from Revit to 
SCIA Engineer and will be shown in the transfer log file. 

 Multiple slabs 

While creating multiple slabs in Revit it is necessary to create them using individual actions in Revit 
rather than continuing the same command. This will ensure the slabs are identified individually 
otherwise they could be lost on export. 
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4 Checking the model 

The following lists the checks you should carry out prior to exporting the model to SCIA Engineer. 

 Analytical checks 

In the Structural Settings dialog under the Analytical Model Settings tab you can activate automatic 
checks for Member Supports and Analytical/Physical Model Consistency. This will mean that Revit will 
automatically adjust your model and check for inconsistencies.  

 

Figure 4-1: Revit - Structural settings  

In case you prefer to apply these checks manually, leave them unchecked, and when you are ready 
run the Check Supports and Consistency Checks from the Analyze Tab. 

 

Figure 4-2: Revit – Analysis check options  
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In Revit SCIA Engineer link, the standard Revit command to perform Analytical Consistency Check is 
automatically invoked before starting the export. It checks for any errors/warnings and prompts you 
to review the same prior to export. 

 Check supports 

The Member Support check will warn and highlight any unsupported elements within the model. You 
can choose to show or delete the check elements depending on the warning you get. If you use the 
show option you can adjust the properties of the element as required. 

 

Figure 4-3: Revit - Warnings  

You can access these Warnings once the dialog has been closed by going to the Manage tab – Inquiry 

panel and selecting Warnings . 

 Analytical / Physical consistency check 

The criteria set in the Structural Settings dialog is applied to your model and a warning will be 
generated where the model does not comply. These errors need to be corrected before exporting the 
model to SCIA Engineer. You can use the Show button to highlight the element or use the Revit ID 
number to locate it using the Select by ID on the Modify Tab. 
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5 Configuration settings 

The settings applied inside the Revit to CADS Revit SCIA Engineer Link will affect the way the model 
is transferred between Revit & SCIA Engineer. 

 Options 

Generally the settings inside the Options dialog box should be set-up as follows with a few exceptions 
that are explained in the subsequent section. 

 

Figure 5-1: CADS Revit SCIA Engineer Link - Options dialog  

 National code 

Make sure that the National Code in CADS Revit SCIA Engineer Link matches the National Code set in 
Revit and SCIA Engineer. The National Code depends on the SCIA Engineer Version selected. 

 Mode of Export 

If you have an authorised copy of SCIA Engineer on your system, setting this option to “Direct 
Exchange”will mean that SCIA Engineer will be automatically started and your model will be loaded 
into the program. Setting the option to “file Exchange”will mean that a transfer file will be created in 
the same folder as your Revit model unless you specify a different location. The transfer file will have 
the extension *.R2S. The transfer file can be opened inside SCIA Engineer using either the File-> Import 
option or the File -> Update option. 
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 SCIA Engineer Version 

You will not be able to use the link software unless you configure the version of SCIA Engineer that is 
installed on your system. Click on the field and browse to the location of your Esa.exe file which is 
usually located in your C:\Program Files (x86)\Scia\Engineerxx.x folder”.  

 

Figure 5-2: CADS Revit SCIA Engineer Link - SCIA Engineer version 

 Export selected items only 

Generally you will be exporting/importing the whole model to and from SCIA Engineer. On some 
occasions you may only want to export part of the structure, select the option Export Selected Items 
Only and the link will only export the items selected in Revit to SCIA Engineer. 

  

Figure 5-3: CADS Revit SCIA Engineer Link - Export Selected Items Only 
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  Mapping Details 

The standard cross section and material libraries in both Revit and SCIA Engineer are comprehensive 
but are labelled differently. The materials and cross sections are being mapped between the 
applications using mapping databases. The Database contains the mapping for cross-sections of Revit 
Structural Framing and Structural Columns families and its types with SCIA Engineer sections.  

The user can review the databases, the order of preferences while exporting the model. These options 
are accessible by clicking the respective buttons under “Mapping Details” in the “Options” dialog. 

 

Figure 5-4: CADS Revit SCIA Engineer Link – Mapping Details 

5.6.1 Preferred Tables 

It is recommended that you move the preferred section databases you would like the link to use to 
the top of the list. 

  

Figure 5-5: CADS Revit SCIA Engineer Link - Preferred Database  
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5.6.1.1 Mapping rules 

Set both the Cross Section and Material to “Use if Not found”. This means that if CADS Revit SCIA 
Engineer Link encounters a section or material not currently configured in its databases you will be 
prompted to choose a suitable section from the tables. 

5.6.1.2 Revit family path 

If your installation of Revit does not have the families installed in the default location on your hard 
drive you can use this option to configure the path to the libraries. The default location for the 
families on your hard drive is C:\ProgramData\Autodesk\RVT 20xx\Libraries\UK. 

5.6.2 Mapping tables 

This dialog, details the default mapping tables that are shipped with the CADS Revit SCIA Engineer 
Link. It illustrates the default Revit structural families (Materials, Columns and Structural Framing 
families) linked to the corresponding default SCIA Engineer materials/sections. 

 

Figure 5-6: CADS Revit SCIA Engineer Link - Mapping Tables  

For full details on all the settings in the CADS Revit SCIA Engineer Link Options dialog refer to the 
Getting Started Guide and the Help file. 

5.6.2.1 User tables 

For non-standard materials and sections or if there are any changes in the name of the default Revit 
family, the materials or sections will not be mapped automatically, but a comprehensive algorithm 
has been developed which will suggest the equivalent sections in SCIA Engineer. The user can accept 
the suggested materials or sections, or map the equivalent section manually by loading all the 
databases, types and sections. These mappings will then be added to the User Table. 

On first use of CADS Revit SCIA Engineer Link the user table will be blank and will be populated with 
user defined mappings as they are created by the user. 

5.6.3 Section Parameter Mapping 

The section parameter mapping is now saved with the project, unlike previously, where it was valid 
for the current session. The mapping data will be available when the project is closed and reopened. 
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Figure 5-7: CADS Revit SCIA Engineer Link – Section Parameter Mapping  

Upon completing the export, the mapping can be reviewed by opening the Section Parameter 
Mapping dialog from Options. 

 

Figure 5-8: CADS Revit SCIA Engineer Link - Options  

You can view, edit or delete the saved parameters that are being used in the project. 

 

Figure 5-9: CADS Revit SCIA Engineer Link – Section Parameter Mapping  
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6 Export / Import tools 

On the first attempt to export the model to SCIA Engineer after you have checked the analytical model, 
it is recommended that you open the Options dialog and check the configuration settings as explained 
in Section 5 above. It is recommended to “Purge and Save the Model” before Exporting the Model to 
SCIA. The purge command will help to reduce the size of the Revit model and is available from the 
Manage tab. 

Select the Export to SCIA Engineer option. 

 

Figure 6-1: CADS Revit SCIA Engineer Link – Export to SCIA Engineer  

The Log dialog is displayed and CADS Revit SCIA Engineer Link will read the Revit model, it will make 
a list of the total number of items from each category that is to be exported. 

When CADS Revit SCIA Engineer Link encounters a material that is not in the material table, you will 
need to manually map the equivalent material. To make the user mapping easier, if a section or 
material is not found, CADS Revit SCIA Engineer Link suggests a set of possible sections or materials.  

 

Figure 6-2: CADS Revit SCIA Engineer Link - Material Mapping  
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The “Material class” defined in Revit determines the equivalent material category in SCIA. Based on 
the material class, National code and the strength, the application will attempt to automatically find 
the equivalent material in SCIA Engineer. 

If the application finds the exact material, which satisfies the material class, national code and strength 
it will be automatically mapped and this material will not be listed in the UI. If no equivalent material 
is found for one or more materials, a unified material mapping dialog will be shown and the user can 
map all the materials. 

 

Figure 6-3: CADS Revit SCIA Engineer Link - Material Mapping – Suggested Mapping 

If the material class in Revit is Concrete, Metal, Masonry, wood, the application will, by default, set 
the appropriate category and the user can then select the correct material from the standard list of 
materials that are available in SCIA Engineer. 

When CADS Revit SCIA Engineer Link encounters a section that is not in the section tables, a unified 
section mapping dialog will be shown and the user can map all the cross sections. If the name of the 
family type matches exactly with the SCIA Engineer section, the section will not be listed in the UI. 
Otherwise, the application will suggest the equivalent SCIA Engineer section using an algorithm. This 
algorithm identifies the equivalent section by reading the family name, respective database and the 
family type.  

 

Figure 6-4: CADS Revit SCIA Engineer Link - Cross Section Mapping  

On completion of the export routine, the Log dialog shows a summary of the number of items 
exported. You can save a log file which can be opened in a text editor to review the transfer. 
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Figure 6-5: CADS Revit SCIA Engineer Link - Model exchange log  

 Filter 

The filter option will allow you to locate any elements in the Revit model that have not been exported 
to SCIA Engineer.  

 

Figure 6-6: CADS Revit SCIA Engineer Link - Filter - Non Exported Items  

Tick the elements you want to review and then click the show option; they will be highlighted in your 
Revit model. 

 Log files 

The Log file is a text file which itemises each element that has been transferred between Revit and 
SCIA Engineer. It details the section / material and its mapping. Any elements that have not been 
successfully transferred are shown in red. At the end of the transfer of the model from Revit to SCIA 
Engineer and vice versa you are given the option to save this file and review it.  
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The Log file will show the Revit ID number of an element that has not transferred to/from SCIA 
Engineer. You can use the Select by ID command (Manage Tab) to highlight and investigate these 
elements in the Revit. 

 Select changes 

This option will help you to review any changes that have been made to the Revit model when you 
import the model from SCIA Engineer. In the diagram below the section size of the concrete column 
was increased. Choosing the Section Size option on the Select Changes command will highlight the 
amended column in Revit.  

 

Figure 6-7: CADS Revit SCIA Engineer Link - Select Changes  

 Import / Export limitations 

Refer to the Help pages in CADS Revit SCIA Engineer Link for the full list of items supported & 
unsupported in Revit and the corresponding items in SCIA Engineer. Also shown is a table of how 
physical Revit objects are transferred between Revit and SCIA Engineer. Refer to the topic on the Bi 
Directional Link between Revit and SCIA Engineer. 


